REN ESAS Application Note

Integrated Development Environment e? studio
How to use IAR Systems compiler in e? studio

Introduction

When you will install IAR Eclipse plugins on the e? studio, you can develop projects (create projects,
configure Build options, and execute Build) on the e? studio using the IAR Systems compilers.

This document describes the procedure for using the IAR Systems compiler on the e? studio.
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1. Overview

1.1 Purpose

e? studio is an integrated development environment for Renesas microcontrollers based on the open source
"Eclipse". By embedding various plugins of Eclipse, e? studio is possible to realize work with external tool
and add/extend features.

If you want to develop projects (create projects, configure Build options, and execute Build) on the e? studio
using the IAR Systems compilers, you need to install IAR Embedded Workbench on your PC and then install
the IAR Eclipse plugins on the e? studio.

This document describes the setup procedure for using IAR Systems compilers on the e? studio, as well as
the procedures for creating a project, configuring Build options, and executing Build using IAR Systems
compilers.

* As an example, the case of using IAR ARM compiler for RA project on the e? studio is described.
* The IAR Eclipse plugins support various Renesas devices other than the RA family.

Refer to the following page for supported devices and compilers.

IAR Embedded Workbench for Eclipse

e The basic procedures are the same when using compilers for devices other than the RA family.
When using a compiler for non-RA family devices, please read to replace the device name and
compiler name.

*  When incorporating a Flexible Software Package (FSP) into a project for the RA or RZ family that
uses the IAR Systems compilers, we recommend using a standalone FSP configurator (RA Smart
Configurator: RASC or RZ Smart Configurator: FSP SC) in combination with IAR Embedded
Workbench.

The standalone FSP configurator is available on the page (Software - Middleware, Drivers, OS |
Renesas) of each FSP.

If using RASC with IAR Embedded Workbench or Keil MDK, see RASC User Guide for MDK and
IAR.

RA Flexible Software Package Documentation: Starting Development (renesas.github.io)

[IAR Eclipse plugins]

IAR Eclipse plugins control IAR Systems compilers on the e? studio, allowing you to create projects,
configure Build options, and execute Build of IAR Systems compilers on the e? studio.

1.2 Environment
This content is described based on the following environment:

[OS]
*  Windows10 64bits
[Tool]
*  e?studio 2024-07
* |AR Eclipse plugins
* |AR Embedded Workbench (include ARM Compiler)
In advance, please install the e? studio to your PC.
This is a usage of combination with the products of IAR Systems, Renesas does not guarantee operation.

Please ask IAR Systems (and its distributors) for detailed specifications and usage of IAR Systems
compilers, IAR Eclipse plugins, and C-SPY debuggers.
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2. Install IAR Embedded Workbench
Purchase or obtain IAR Embedded Workbench for Arm from IAR Systems and install it.

You can download the evaluation version of IAR Embedded Workbench for Arm from IAR Systems web site
(https://www.iar.com/). However, user registration is required to download.

If you want to create a project for devices other than the RA family, please purchase or obtain IAR
Embedded Workbench for your device.
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3. Install IAR Eclipse plugins
This chapter describes how to install IAR Eclipse plugins on the e? studio.

. If the installation of the IAR Eclipse plugins fails by following the instructions described in this
chapter, please download plugins by yourself from IAR Embedded Workbench for Eclipse and
install it referring to the following page.

How to Install a Generic Eclipse Plug-in on e? studio | Renesas Customer Hub
1) Launch e? studio after finish installing IAR Embedded Workbench.
2) Select menu item [Help] > [IAR Embedded Workbench plugin manager...].

3) The [Progress Information] message appears, confirming the existing plugins.

Progress Information

IO' Operation in progress...
o

Check plugin availability for ARM

Cancel

Figure 1

4) The [IAR Embedded Workbench plugin manager] dialog appears after finish confirming the existing
plugins. Choose an installed version of IAR Embedded Workbench for Arm with the [Supported targets]
list box and the [Available IAR Embedded Workbench installations] list box. And press the [Install]
button.

«' |AR Embedded Workbench plugin manager

Manage IAR Embedded Workbench Eclipse plugins

Select your target in the left pane, then select a plugin to install in the right pane.

Supported targets Available IAR Embedded Workbench installations
Target Installed plugin 2 Version Status IAR Embedded Workbench Installation path
ARM (6.50x) -- not installed -- 9.50.2 iy Plugin available C:¥Program Files¥IAR Systems¥Embedded Workbench 9.2
ARM (8.10-8.22) -- not installed --
ARM (8.30-8.50) -- not installed --
ARM (7.20 to 7.80) -- not installed --
ARM (9.x) -- not installed --

Add IAR Embedded Workbench installation...

® Install Cancel

Figure 2

5) The download of plugins will begin. The download will proceed in the background. And the progress will
be displayed on the status bar. Press the [Shows background operations in Progress view] button,
[Progress] view is opened.

Note: Downloading plugins takes time.
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= Progress X

Configuring IAR plugins
T

Figure 3

6) The [Install - Install] dialog appears after finish downloading plugins. Press the [Next >] button.

«' Install

Install

Check the items that you wish to install.

-

)~

Name Version

QﬂsIAR C-SPY Debug Support for Arm (9x) 9.0.0.202407151343
QﬂsIAR Common Components 4.2.0.202407151343
QﬂsIAR Common Debugger Components  2.1.0.202407151343

QS‘:IAR Toolchain for Arm (9.x) 9.0.0.202407151343

Id
com.iarcdt.arm.debuggerfeature.feature.group
com.iar.common.feature feature.group
com.iarcommon.debuggerfeature. feature.group
com.arcdtarm.sdk.feature.feature.group

Select All Deselect All

Details

IAR debugger integration for Arm.

@

< Back

Finish Cancel

Figure 4

7) The [Install - Install Details] dialog appears. Press the [Next >] button.

e Install

Install Details

Review the items to be installed.

-

)

Name Version

? Qﬂ: IAR C-5PY Debug Support for Arm (9x) 9.0.0.202407151343
Qﬁ‘s IAR Common Components 4.2.0.202407151343
Qﬂs IAR Common Debugger Components  2.1.0.202407151343

Qﬂs IAR Toolchain for Arm (9.x) 9.0.0.202407151343

Id
com.arcdt.arm.debuggerfeature.feature.group
com.arcommon.feature feature.group
com.arcommon.debugger.feature feature.group
com.iarcdtarm.sdk feature feature.group

Size: 32,437 KB
Details

14R dabiiaase intearstion for dmm

@

< Back

Finish Cancel

Figure 5

8) The [Install - Review Licenses] dialog appears. Accept terms of license agreement and turn on the
check box "l accept terms of the license agreements”. Then, press the [Finish] button in order to start

the install of plugins.
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«' Install

Review Licenses

-

EMF Data Binding 1.11.0v20231208-1346

~ SOFTWARE LICENSE AGREEMENT
IAR Common Components (WTDX runtime) 1.0.1.20240715
IAR Common Components 4.2.0.202407151343

November 22, 2017

Usage Of Content

Licenses must be reviewed and accepted before the software can be installed. -3 -
b
Licenses: License text:
~ Eclipse Foundation Software User Agreement Eclipse Foundation Software User Agreement ~

IAR Common Debugger Componenits 2.1.0.202407151343 || THE ECLIPSE FOUNDATION MAKES AVAILABLE v

IAR C-SPY Debug Support for Arm (9.x) 9.0.0.202407151341

1AR Toolchain for Arm (9.x) 9.0.0.202407151343 @ | accept the terms of the license agreements
< > | O do not accept the terms of the license agreement

® < Back Next > Cancel

Figure 6

9) The install of the plugins will start. The installation will proceed in the background.

Note: Installing plugins takes time.

10) The [Trust Authorities] message appears during installation. Press the [Select All] button and press the

[Trust Selected] button.

e Trust Authorities

configuration and may potentially be used for malicious purposes.

Do you trust content originating from the following authorities? Installing content involves performing actions that alter the installation's

Authority / Update Site
> [m] https://eclipse-update.iarcom

Units Secured
36 ¢

Remember selected authorities [ ] Always trust all authorities Select All Deselect All

Expand All Collapse All

| ~ *larcom; LA.R. Systems AB

€2

Details... | Export...

@

Id Version 2
com.google.gson 2.8.2.v20180104-1110

com.google.guava 30.1.0.v20221112-0806

com.iar.cdt.arm.debugger 2.3.0.202407151343

com.iar.cdt.arm.debugger.cmsisdap 1.0.0.202407151343

com.iar.cdt.arm.debugger.feature.feature.group 9.0.0.202407151343

com.iar.cdt.arm.debugger.feature.feature.jar 9.0.0.202407151343 v
Details...

Trust Selected Cancel

Figure 7

11) The [Trust Authorities] message appears again during installation. Press the [Select All] button and

press the [Trust Selected] button.
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e Trust Artifacts

Do you trust these signers? 4+ Do you trust unsigned content of unknown origin? 4 The displayed originator names are not necessarily a
reliable certification of origin. For PGP keys, verification is typically achieved by querying the key's fingerprint against a trusted key server.

Type Id/Fingerprint Name Validity Dates

PGP 65af8ad45d95ddfc7efba7b5b.. + Valid, expires 2028-05-01...
PGP 2e20288fb%9ac6b506874991f5... + Valid, expires 2028-07-01...
PGP 1c6f3d42d6ebb0726615559¢7 ... + Valid, expires 2027-11-09...
Unsigned n/a Unknown n/a

Remember selected signers [ ] Always trust all content Select All Deselect All

| 65af8ad45d95ddfc7efba7b5ba23161e259d09cc

Details... | Export...

Classifier Id Version

osgi.bun... com.googlecode.javaewah.JavaEWAH 1.2.3

osgi.bun... org.apache.commons.cli 1.6.0

osgi.bun... org.apache.commons.lang 2.6.0.v201404270220
osgi.bun... org.jsoup 1.7.2.v201411291515

® Trust Selected Cancel

Figure 8

12) When the installation is completed, the following message appears to install e2 studio. Press the
[Restart Now] button.

e’ Software Updates

Restart e® studio to apply the software update?

T

Figure 9
13) After restart e? studio, select menu item [Help] > [IAR Embedded Workbench plugin manager...] again.

If the plugins have been successfully installed, version number is displayed on "Installed plugin” in
[Supported targets] list box. Press the [Cancel] button.

¢ |AR Embedded Workbench plugin manager

Manage IAR Embedded Workbench Eclipse plugins

Select your target in the left pane, then select a plugin to install in the right pane.

Supported targets Available IAR Embedded Workbench installations

Target Installed plugin 2 Version Status IAR Embedded Workbench Installation path

ARM (6.50.x) 9.0.0.202407151343 O 9.50.2 3¢ Plugininstalled C:¥Program Files¥lAR Systems¥Embedded Workbench 9.2
ARM (8.10-8.22) 9.0.0.202407151343

ARM (8.30-8.50) 9.0.0.202407151343

ARM (7.20 to 7.80) 9.0.0.202407151343

ARM (9x) 9.0.0.202407151343 .,

Add IAR Embedded Workbench installation...

@ Install Cancel

Figure 10
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4. Creating a project

When IAR Eclipse plugins installation is complete, you can create RA family projects for using IAR Systems
compiler, configure Build options, and execute Build for that project.

This chapter describes how to create a project.
1) Select the menu [File] > [New] > [Renesas C/C++ Project] > [RA Project].

2) The [New C/C++ Project - Templates for RA Project] dialog appears. Choose the "Renesas RA C/C++
Project". And press the [Next >] button.

e’ New C/C++ Project

Templates for Renesas RA Project
Renesas RA C/C++ Project
C/C++ F=== Create an executable or static library G/C++ project
for Renesas RA.
® < Back Finish Cancel
Figure 11

3) The [Renesas RA C/C++ Project - Project Name and Location] dialog appears. Input project name in the
[Project name] textbox. And press the [Next >] button.

«' Renesas RA C/C++ Project

Renesas RA C/C++ Project - O

Project Name and Location

Project name

[samplelar

Use default location

E:¥e2 studio¥workspace 2024-07 IAR¥SamplelAR Browse...

You can download more Renesas packs here

@ < Back Finish Cancel

Figure 12

4) The [Renesas RA C/C++ Project - Devices and Tools Selection] dialog appears. Choose the suitable
board and device for your project. And choose the "IAR Toolchain for Arm - (9.x)" in the [Toolchains] list
box. Next, press the [Next >] button.

R20AN0733EJ0200 Rev.2.00 Page 8 of 13
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« Renesas RA C/C++ Project

Renesas RA C/C++ Project —

Device and Tools Selection

Device Selection
Board Description
Evaluation kit for RAéM4 MCU Group

FSP Version: |5.4.0 v

Board: EK-RABM4 v

Visit https://www.renesas.com/ra/ek-rabm4 to get kit user's
Device: R7FABMAAF3CFB manual, guick start guide, errata, design package, example
projects, etc.

Core: CM33
Language: @®C OCs+ Device Details
TrustZone Yes
Pins 144
Processor Cortex-M33
Toolchains Debugger
GNU ARM Embedded J-Link ARM =

IAR Toolchain for Arm - (9.x)

~ Manage Toolchains...

® < Back Finish Cancel

Figure 13

5) For the next page and any following pages, please set the suitable values for your project and press the
[Finish] button on the last page.

6) The created project is shown on the [Project Explorer] view.
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5. Configuring Build options

To configure Build options for the Compiler, Assembler, Linker, and more, select your project in the [Project

Explorer] view and perform one of the following operations.

e Select the menu [Project] > [C/C++ Project Settings].

*  Select the context menu [C/C++ Project Settings].

The [Tool Settings] tab in the [Properties] dialog appears. You can configure Build options.

«' Properties for SamplelAR

|Type filter text

Resource
Builders
w CfC++ Build
Build Vanables
Environment
Logging
Settings
Tool Chain Editor
C/C++ General
C-SPY
C-STAT Static Analysis
Project Natures
Project References
Renesas QE
Run/Debug Settings
Task Tags
Validation

Settings

Configuration: |Debug [ Active ]

53 Tool Settings | # Build Steps

~ | | Manage Configurations...

Build Artifact i' Binary Parsers| € Error Parsers

é? Target

(5 32-bit

(52 64-bit

(2 Library Configuration

3;3 Library Options 1

ii? Library Options 2

(2 Multi-file Compilation
(22 C-RUN Runtime Checking

é_-ﬁ Language

E—-'E Code

é_-? Optimizations

é? Qutput

(52 List

é? Preprocessor

é’f Diagnostics

é_-ﬁ Encodings

E—-'E Extra Options
3 1AR Assembler for Arm
&3 IAR Linker for Arm

X

~ 133 IAR C/C++ Compiler for Arm

Processor core:

Renesas R7TFABM4AF
Cortex-M33 ™

32-bit

Apply and Close Cancel

Figure 14
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6. Executing Build

To execute the Build, select your project in the [Project Explorer] view and perform one of the following
operations.

e Select the menu [Project] > [Build Project].

e Select the context menu [Build Project]

Notes:

To use IAR Systems compiler, you need to register a license. If the license is not registered, the following
error will occur at execute Build time.

Fatal error[LMS001]: License check failed. Use the IAR License manager to resolve the
problem.

Register the license from "IAR License Manager". "IAR License Manager" is installed together with "IAR
Embedded Workbench".
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7. Reference information

7.1 Web site

* |AR Systems
https://www.iar.com/
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Revision History
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Rev. Date Page Summary
Rev.1.00 | Oct.03.23 - First edition
Rev.1.01 | Jul.03.24 Page2 1.1 Purpose
Added recommended method for using FSP with RA/RZ family.
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General Precautions in the Handling of Microprocessing Unit and Microcontroller
Unit Products

The following usage notes are applicable to all Microprocessing unit and Microcontroller unit products from Renesas. For detailed usage notes on the
products covered by this document, refer to the relevant sections of the document as well as any technical updates that have been issued for the products.
1. Precaution against Electrostatic Discharge (ESD)
A strong electrical field, when exposed to a CMOS device, can cause destruction of the gate oxide and ultimately degrade the device operation. Steps
must be taken to stop the generation of static electricity as much as possible, and quickly dissipate it when it occurs. Environmental control must be
adequate. When it is dry, a humidifier should be used. This is recommended to avoid using insulators that can easily build up static electricity.
Semiconductor devices must be stored and transported in an anti-static container, static shielding bag or conductive material. All test and
measurement tools including work benches and floors must be grounded. The operator must also be grounded using a wrist strap. Semiconductor

devices must not be touched with bare hands. Similar precautions must be taken for printed circuit boards with mounted semiconductor devices.
2. Processing at power-on

The state of the product is undefined at the time when power is supplied. The states of internal circuits in the LSI are indeterminate and the states of
register settings and pins are undefined at the time when power is supplied. In a finished product where the reset signal is applied to the external reset
pin, the states of pins are not guaranteed from the time when power is supplied until the reset process is completed. In a similar way, the states of pins
in a product that is reset by an on-chip power-on reset function are not guaranteed from the time when power is supplied until the power reaches the

level at which resetting is specified.
3. Input of signal during power-off state

Do not input signals or an 1/0 pull-up power supply while the device is powered off. The current injection that results from input of such a signal or I/0
pull-up power supply may cause malfunction and the abnormal current that passes in the device at this time may cause degradation of internal

elements. Follow the guideline for input signal during power-off state as described in your product documentation.
4. Handling of unused pins

Handle unused pins in accordance with the directions given under handling of unused pins in the manual. The input pins of CMOS products are
generally in the high-impedance state. In operation with an unused pin in the open-circuit state, extra electromagnetic noise is induced in the vicinity of
the LSI, an associated shoot-through current flows internally, and malfunctions occur due to the false recognition of the pin state as an input signal

become possible.
5. Clock signals

After applying a reset, only release the reset line after the operating clock signal becomes stable. When switching the clock signal during program
execution, wait until the target clock signal is stabilized. When the clock signal is generated with an external resonator or from an external oscillator
during a reset, ensure that the reset line is only released after full stabilization of the clock signal. Additionally, when switching to a clock signal

produced with an external resonator or by an external oscillator while program execution is in progress, wait until the target clock signal is stable.
6. Voltage application waveform at input pin

Waveform distortion due to input noise or a reflected wave may cause malfunction. If the input of the CMOS device stays in the area between V.
(Max.) and Vi (Min.) due to noise, for example, the device may malfunction. Take care to prevent chattering noise from entering the device when the

input level is fixed, and also in the transition period when the input level passes through the area between Vi. (Max.) and Vix (Min.).
7. Pronhibition of access to reserved addresses

Access to reserved addresses is prohibited. The reserved addresses are provided for possible future expansion of functions. Do not access these

addresses as the correct operation of the LSl is not guaranteed.
8. Differences between products

Before changing from one product to another, for example to a product with a different part number, confirm that the change will not lead to problems.
The characteristics of a microprocessing unit or microcontroller unit products in the same group but having a different part number might differ in terms
of internal memory capacity, layout pattern, and other factors, which can affect the ranges of electrical characteristics, such as characteristic values,
operating margins, immunity to noise, and amount of radiated noise. When changing to a product with a different part number, implement a system-
evaluation test for the given product.



Notice

1.

12.

13.
14.

(Note1)

Descriptions of circuits, software and other related information in this document are provided only to illustrate the operation of semiconductor products
and application examples. You are fully responsible for the incorporation or any other use of the circuits, software, and information in the design of your
product or system. Renesas Electronics disclaims any and all liability for any losses and damages incurred by you or third parties arising from the use
of these circuits, software, or information.
Renesas Electronics hereby expressly disclaims any warranties against and liability for infringement or any other claims involving patents, copyrights,
or other intellectual property rights of third parties, by or arising from the use of Renesas Electronics products or technical information described in this
document, including but not limited to, the product data, drawings, charts, programs, algorithms, and application examples.
No license, express, implied or otherwise, is granted hereby under any patents, copyrights or other intellectual property rights of Renesas Electronics
or others.
You shall be responsible for determining what licenses are required from any third parties, and obtaining such licenses for the lawful import, export,
manufacture, sales, utilization, distribution or other disposal of any products incorporating Renesas Electronics products, if required.
You shall not alter, modify, copy, or reverse engineer any Renesas Electronics product, whether in whole or in part. Renesas Electronics disclaims any
and all liability for any losses or damages incurred by you or third parties arising from such alteration, modification, copying or reverse engineering.
Renesas Electronics products are classified according to the following two quality grades: “Standard” and “High Quality”. The intended applications for
each Renesas Electronics product depends on the product’s quality grade, as indicated below.

"Standard": Computers; office equipment; communications equipment; test and measurement equipment; audio and visual equipment; home

electronic appliances; machine tools; personal electronic equipment; industrial robots; etc.
"High Quality": Transportation equipment (automobiles, trains, ships, etc.); traffic control (traffic lights); large-scale communication equipment; key
financial terminal systems; safety control equipment; etc.

Unless expressly designated as a high reliability product or a product for harsh environments in a Renesas Electronics data sheet or other Renesas
Electronics document, Renesas Electronics products are not intended or authorized for use in products or systems that may pose a direct threat to
human life or bodily injury (artificial life support devices or systems; surgical implantations; etc.), or may cause serious property damage (space
system; undersea repeaters; nuclear power control systems; aircraft control systems; key plant systems; military equipment; etc.). Renesas Electronics
disclaims any and all liability for any damages or losses incurred by you or any third parties arising from the use of any Renesas Electronics product
that is inconsistent with any Renesas Electronics data sheet, user's manual or other Renesas Electronics document.
No semiconductor product is absolutely secure. Notwithstanding any security measures or features that may be implemented in Renesas Electronics
hardware or software products, Renesas Electronics shall have absolutely no liability arising out of any vulnerability or security breach, including but
not limited to any unauthorized access to or use of a Renesas Electronics product or a system that uses a Renesas Electronics product. RENESAS
ELECTRONICS DOES NOT WARRANT OR GUARANTEE THAT RENESAS ELECTRONICS PRODUCTS, OR ANY SYSTEMS CREATED USING
RENESAS ELECTRONICS PRODUCTS WILL BE INVULNERABLE OR FREE FROM CORRUPTION, ATTACK, VIRUSES, INTERFERENCE,
HACKING, DATA LOSS OR THEFT, OR OTHER SECURITY INTRUSION (“Vulnerability Issues”). RENESAS ELECTRONICS DISCLAIMS ANY AND
ALL RESPONSIBILITY OR LIABILITY ARISING FROM OR RELATED TO ANY VULNERABILITY ISSUES. FURTHERMORE, TO THE EXTENT
PERMITTED BY APPLICABLE LAW, RENESAS ELECTRONICS DISCLAIMS ANY AND ALL WARRANTIES, EXPRESS OR IMPLIED, WITH
RESPECT TO THIS DOCUMENT AND ANY RELATED OR ACCOMPANYING SOFTWARE OR HARDWARE, INCLUDING BUT NOT LIMITED TO
THE IMPLIED WARRANTIES OF MERCHANTABILITY, OR FITNESS FOR A PARTICULAR PURPOSE.
When using Renesas Electronics products, refer to the latest product information (data sheets, user’'s manuals, application notes, “General Notes for
Handling and Using Semiconductor Devices” in the reliability handbook, etc.), and ensure that usage conditions are within the ranges specified by
Renesas Electronics with respect to maximum ratings, operating power supply voltage range, heat dissipation characteristics, installation, etc. Renesas
Electronics disclaims any and all liability for any malfunctions, failure or accident arising out of the use of Renesas Electronics products outside of such
specified ranges.
Although Renesas Electronics endeavors to improve the quality and reliability of Renesas Electronics products, semiconductor products have specific
characteristics, such as the occurrence of failure at a certain rate and malfunctions under certain use conditions. Unless designated as a high reliability
product or a product for harsh environments in a Renesas Electronics data sheet or other Renesas Electronics document, Renesas Electronics
products are not subject to radiation resistance design. You are responsible for implementing safety measures to guard against the possibility of bodily
injury, injury or damage caused by fire, and/or danger to the public in the event of a failure or malfunction of Renesas Electronics products, such as
safety design for hardware and software, including but not limited to redundancy, fire control and malfunction prevention, appropriate treatment for
aging degradation or any other appropriate measures. Because the evaluation of microcomputer software alone is very difficult and impractical, you are
responsible for evaluating the safety of the final products or systems manufactured by you.

. Please contact a Renesas Electronics sales office for details as to environmental matters such as the environmental compatibility of each Renesas

Electronics product. You are responsible for carefully and sufficiently investigating applicable laws and regulations that regulate the inclusion or use of
controlled substances, including without limitation, the EU RoHS Directive, and using Renesas Electronics products in compliance with all these
applicable laws and regulations. Renesas Electronics disclaims any and all liability for damages or losses occurring as a result of your noncompliance
with applicable laws and regulations.

. Renesas Electronics products and technologies shall not be used for or incorporated into any products or systems whose manufacture, use, or sale is

prohibited under any applicable domestic or foreign laws or regulations. You shall comply with any applicable export control laws and regulations
promulgated and administered by the governments of any countries asserting jurisdiction over the parties or transactions.

It is the responsibility of the buyer or distributor of Renesas Electronics products, or any other party who distributes, disposes of, or otherwise sells or
transfers the product to a third party, to notify such third party in advance of the contents and conditions set forth in this document.

This document shall not be reprinted, reproduced or duplicated in any form, in whole or in part, without prior written consent of Renesas Electronics.
Please contact a Renesas Electronics sales office if you have any questions regarding the information contained in this document or Renesas
Electronics products.

“Renesas Electronics” as used in this document means Renesas Electronics Corporation and also includes its directly or indirectly controlled
subsidiaries.

(Note2)

Corporate Headquarters
TOYOSU FORESIA, 3-2-24 Toyosu,
Koto-ku, Tokyo 135-0061, Japan
www.renesas.com

Trademarks

Renesas and the Renesas logo are trademarks of Renesas Electronics
Corporation. All trademarks and registered trademarks are the property
of their respective owners.

“Renesas Electronics product(s)” means any product developed or manufactured by or for Renesas Electronics.
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version of a document, or your nearest sales office, please visit:
www.renesas.com/contact/.
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